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About this Manual
Notice
The information in this document has been produced by PHABRIX Ltd with care and is believed to 
be accurate. PHABRIX Ltd does not assume responsibility for loss or damage resulting from errors, 
omissions or inaccuracies herein. This document is subject to change and revisions may be made and 
issued to include such changes.

No part of this document may be reproduced, stored in a retrieval system or transmitted in any form 
or by any means, electronic, mechanical, recorded or otherwise without the prior written consent of 
PHABRIX Ltd.

Copyright © PHABRIX Ltd. All rights reserved. Software products licensed are owned by PHABRIX Ltd 
and are protected by international treaty provisions and national copyright laws.

HDMI ® is the registered trademark of HDMI Licensing and is used within the document for 
identification purposes only. 

Revision
This manual is a revision controlled document. Any changes to any page content will be reflected in 
the overall revision status of the whole manual.

Release Date Software Version Updates including:

1 23 Jan 2017 1.0.0.196 First release of manual

2 21 Mar 2017 1.0.1.227 Addition of Waveform, Vectorscope, HDMI audio and 
new video standards.

3 20 Jun 2017 1.0.2 Reference locking support with Output offset 
adjustment. Input timing against reference with Input 
Measurement Offset.

4 21 Aug 2017 1.0.3 HDR Heat-map, CIE 1931 x y Chart, HDR/WCG 
additions for Waveform and Vectorscope, and new 
PQ video standards.  REST API for remote control 
and automation. CRC Analysis frame change 
detection added. 

5 7 Sep 2017 1.0.3 Driver Calibration description

6a 6 Nov 2017 2.0 New 2022-6 IP instrument suite. Support for 1.5 & 3G 
standards over IP. Support for IP Transmit reference 
locking. IP Decapsulated SDI timing against 
reference with Input Measurement Offset. SDI/IP 
mode firmware switching. CIE Chart pan and zoom.

7 21 Dec 2017 2.0.1 32 channel Audio Generation. Extended REST 
API support for audio generation, and CRC error 
reporting, Cursors linking Picture, Dataview, and 
Waveform. Qx factory default setting. 

8 4 May 2018 2.2 Screen capture, moving test patterns, layout Presets, 
VNC, SFTP, web browser. New HLG video standards, 
new Rec. 2020 support, PsF video standards. Audio 
monitoring on SDI Instrument Output. Extended 
REST API support for 2022-6 IP instrument suite. 

PHABRIX® Limited

Omega House,					     phone + 44 (0)1635 873030  
Enterprise Way, 
Thatcham, Berkshire				    email: support@phabrix.com  www.phabrix.com 
RG19 4AE 
United Kingdom

mailto:info%40phabrix.com?subject=
http://www.phabrix.com
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Getting Started
Package Contents
The shipping box should contain the following:

PHABRIX Qx 12G unit: PHQX01 or PHQX01E (with Physical Layer Analysis) or

PHABRIX Qx IP unit: PHQX01-IP or PHQX01E-IP (with Physical Layer Analysis);

Power Supply Unit;

Mains lead

PHABRIX USB Key

General Safety

Avoiding Personal Injury
		  This instrument is designed for use by qualified personnel only.

		  No user serviceable parts are provided. Units should be returned to your local PHABRIX 		
		  agent for servicing.

		  The Operator should NOT remove the case from the unit.

		  Do not spill any liquid onto the unit or its power adaptor.

Power Supply
Make sure that the unit is connected to the correct power supply voltage. A power supply adaptor is 
supplied with the unit which may be connected to any AC power supply between 100 and 240VAC at 
50-60Hz. Only the supplied power adaptor should be used with the unit. Do not use a damaged AC cable 
with the unit as it may cause a shock or fire hazard. Replacement AC cables are available from your local 
PHABRIX agent.

How to Upgrade Software
New software releases will be made available regularly as the product is developed. 

Software downloads are approximately 100 MB and can be found in the Support area of the PHABRIX 
website currently located at www.phabrix.com/support.asp 

Download the .ZIP file.

Extract and copy the ‘phab_qx_upgrade.bin’ file to the root directory of a FAT32 formatted USB stick.

Make sure the unit is turned OFF before upgrading.

Insert the USB into the front panel USB port. 

Press the power button TWICE in succession. The power button will glow pink when the upgrade procedure 
begins. If the button does not glow pink then repeat the procedure.

The power button will flash several colors and the fans will be on full throughout the upgrade process. 
Please wait approximately 4 minutes as the unit upgrades. It will automatically show the menu screen when 
complete.
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Installation Environment

Operating Temperature

	 The unit should only be operated between 0 and 40 °Celsius non condensing. If the 
temperature is changed rapidly from a cold environment to a hot environment, moisture can 
be created internally which can cause malfunction or damage the unit. Allow the unit to sit for 
30 minutes without power applied to reduce any possibility of condensation. If the internal 
component temperature rises above 85°Celsius the unit will turn OFF automatically.

Input/Output Terminals
Do not connect the input or output BNC connectors to external power as this can damage the internal 
circuitry and cause the unit to work incorrectly.

The BNC connectors fitted on this unit are 75Ω type which are not compatible with 50Ω plugs. 

	 The use of 50Ω plugs will permanently damage the connectors on the unit. The use of 50Ω 
plugs is considered to be misuse of the equipment and will therefore invalidate the unit’s 
warranty.

When Not In Use
Disconnect the unit from the power supply and AC power source when not in use.

Maintenance
Wipe the case gently with a soft cloth, lightly dampened with a neutral cleaning agent.

	 Remove the power supply from the unit and turn OFF before cleaning. Do not allow any water 
or other liquid to enter the unit while cleaning.

RoHS Compliance
PHABRIX products are designed and manufactured using only RoHS compliant components and materials. 
Therefore based on information provided by our suppliers, PHABRIX certifies that ALL products that it 
manufactures are “RoHS-5” compliant and that they do not exceed the designated levels of lead, cadmium, 
mercury, hexavalent chromium, polybrominated biphenyl (PBB) and polybrominated diphenyl ether flame 
retardants (PBDE) legislated under the provisions of the “European Parliament and Council Directive” on the 
“Restriction of the Use of Certain Hazardous Substances in Electrical and Electronic Equipment (2011/65/EC)” 
and associated regulations collective known as the “RoHS Regulations”.

Disposal of Equipment
	 This product is subject to the European WEEE (Waste Electrical and Electronic 

Equipment) directive and should be disposed of according to the regulations of each 
country.
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Icon Display and Meaning
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Overview
Start up

Installation
The rear of the unit shown above, describes the connections and interfaces of the Qx. Before turning on the 
Qx, make sure the following connections are in place:

The XLR power cable is inserted.

For instrument display connect a suitable 1920 x 1080 capable monitor to either the HDMI instrument output 
or the SDI instrument output. Both display outputs carry the selected audio monitoring channel/pair. The 
monitor output can be configured for 1080p60, 1080p59.94 or 1080p50 frame rates using the ‘Display 
Options’ submenu of the ‘Instrument Launch Menu’. For mouse and keyboard control, the two USB ports at 
the rear of the unit should be used.

Note: The following interfaces are temporarily unavailable in this release of software:
•	 LTC In
•	 GPI I/O

•	 AES I/O

Analyzer SDI connections
The Physical Layer input connection for eye and jitter is the rightmost BNC (when viewed from the rear) 
with a red nut. This provides the multirate eye and jitter connection from HD-SDI to 12G-SDI. There are four 
12G-SDI capable input BNCs for the analyzer: SDI IN A, B, C, D. 

Up to four SDI inputs may be connected at any one time, however the system will automatically determine 
the signal set to analyze - be it single link, dual link, or quad link - based on the SMPTE ST 352 packets 
present. The algorithm looks to ‘SDI IN A’ first and then determines the overall standard. 

If the SMPTE ST 352 packets are known to be incorrect then the user has the option to select ‘Ignore 
payload identifier packets (ST 352)’ in the ‘Analyzer - Video Standard’ window.

Generator SDI connections
The generator provides up to four SDI output signals which must form part of the same video signal set e.g. 
12G payload using four 3G-SDI outputs or 12G payload using two 6G-SDI signals.

‘SDI OUT A’ is always present and carries the first signal in the group. ‘SDI OUT B’ is active for dual link 
standards, and ‘SDI OUT C’ and ‘SDI OUT D’ are active for quad link standards.

Generator 
12G/6G/3G/HD BNC x4

Analyzer inputs  
12G/6G/3G/HD BNC x4

(SFP+) MSA/NON-MSA� 12Gbps  
copper or fiber, 10G Ethernet

Networking  
�10/100/1000BASE-T

2x USB 2.0
SDI instrument  
output

Ref loop BNC x 2
HDMI instrument  
output (to 1080p60)

Stereo Audio out, LTC in,
8x GPI I/O, 4x AES I/O

Power 
10 - 18v

Micro USB (Factory service)

••
•••

• • • • • • • •
• •

•

•
•

• •

•

12G/6G/3G/HD Eye



PHABRIX Qx User Manual Page 2

(SFP+) MSA/NON-MSA� 12Gbps  
copper or fiber, 10G Ethernet

Analyzer ST 2022-6 Optical SFP connection
The receive connection for IP video is SFP+A. This is the right hand most SFP when viewed from the rear. 
This provides the multirate 2022-6 IP video analyzer connection from 1.5G HD-SDI to 3G-SDI over IP.

If the SMPTE ST 352 packets are known to be incorrect then the user has the option to select ‘Ignore 
payload identifier packets (ST 352)’ in the ‘Analyzer - Video Standard’ window.

Generator ST 2022-6 Optical SFP connection
The transmit connection for IP video is SFP+B. This is the left hand most SFP when viewed from the rear. This 
provides the multirate 2022-6 IP video packet generation from 1.5G HD-SDI to 3G-SDI over IP.

Note: For both SFP+A and SFP+B, use optical SFPs approved by PHABRIX. Use of incompatible SFPs will 
lead to an error message window appearing on the Qx screen when powered up.

LC to LC optical multi-mode duplex fiber cables should be used. Cables of the following specifications are 
approved by PHABRIX: OM1 (62.5/125), OM2 (50/125), OM3 (50/125), and OM4 (50/125).      

Powering up the Qx
When the ‘Power Button’ on the Qx is first pressed, the unit fans will cycle for 20-30 seconds at high speed 
as the system boots, then settle to their normal operating speed.

 

Menu selection
The following menu screen will be displayed after power up:

To activate the ‘Instrument Launch Menu’, left-click the PHABRIX symbol on the left hand side of the  
‘Instrument Bar’. A ‘Preset Bar’ can be created below the ‘Instrument Bar’. 

To hide the ‘Instrument Bar’, left-click within its blank area. Bringing the cursor to the bottom of screen re-
enables the ‘Instrument Bar’.

Instrument Launch Menu

•

Power Button

•

USB port



PHABRIX Qx User Manual Page 3



PHABRIX Qx User Manual Page 4

As each instrument is selected, an icon will be placed on the ‘Instrument Bar’. Each instrument window frame 
and icon will be assigned a color. Each icon and instrument border will glow in the assigned color to indicate 
that it is part of a ‘group’ of instruments related to Analyzer, Generator, or System. This color coding provides 
easy identification of instrument type. This color ‘Window Frames’ option can be disabled via ‘Display 
Options’ in the ‘Instrument Launch Menu’.

System instrument borders and icons glow white. With the ‘Window Frames’ option in ‘Display Options’ 
enabled, the colors of the Analyzer group and Generator group of tools can be set:

	 • Analyzer tools color select > [color]

	 • Generator tools color select > [color]

Color selection is via the HSV (Hue, Saturation, Value) tool shown above using two cursors. The left-hand 
color rectangle allows selection of hue (horizontal) and saturation (vertical). The right-hand vertical bar 
selects the color lightness.

Instrument borders automatically merge by group color. If one instrument is placed next to another in the 
same group, then the border will outline all instruments of a common group in contact with each other to aid 
group recognition. 

Instrument Bar
All instrument windows can be closed simultaneously by right-clicking the ‘Instrument Bar’ to reveal its 
submenu, and then selecting ‘Close All Windows’. 

In the right-hand corner of the Instrument Bar is the audio monitoring Source icon, and the Time & Date 
display.

The audio monitoring icon controls the audio monitoring output of the unit, whether monitoring via HDMI, 
SDI instrument monitor output, or 26-way D-type. Click once to mute/unmute. Hovering over the icon 
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reveals the current audio Source channel/pair selected, and right-clicking the icon additionally reveals an 
adjustable sliding volume bar. The audio monitoring source can be selected via the ‘Analyzer - Audio Meters’ 
instrument. 

Right-click the time and date display to reveal submenu for settings modification.

For ease of use and convenience, multiple display layouts can be saved as presets, allowing users to save 
bespoke layouts for different operational tasks – accessible from the ‘Preset Bar’ in one click. Once a user 
has organised the screen with the instruments they require, a preset can be saved by right clicking the 
‘Instrument Bar’ and selecting ’Save System State As Preset’ from the submenu.

The ‘Preset Bar’ will appear below the ‘Instrument Bar’, with the current screen layout saved as a preset 
of default name ‘New Preset’. To rename the preset as desired, right-click the preset button and select 
‘Remane Preset’. A prompt window will appear allowing the renaming by USB keyboard of the preset, as 
required.

To save further layout presets, organise the screen as required, and repeat as above.

Selection buttons for all saved presets are available in the ‘Preset Bar’.

To delete a preset, right-click its preset button, and select ‘Delete Preset’. A confirmation dialog box will 
appear. To confirm deletion, select ‘Delete’. If you no longer wish to delete the preset, select ‘Cancel’.

To automatically hide the Preset bar from view, right-click the ‘Instrument Bar’ and check the ‘Auto-hide 
Presets’ checkbox. To display the ‘Preset Bar’, uncheck the ‘Auto-hide Presets’ checkbox.

Instrument Navigation
Each instrument also has a submenu. The submenu is activated by right-clicking the mouse in the window, 
enabling a drop-down configuration menu. Click and drag on the grey bar at the top of the submenu to 
move it. In addition to window-specific commands, the option to ‘Close’ the instrument is provided in its 
submenu; as is the option to ‘Dismiss’ the submenu.

Example of drop-down submenu on right mouse click:

There is also the option to take a screenshot of the entire display by selecting ‘Take Screenshot’ in the 
submenu of any instrument. Alternatively, via a keyboard, press ‘SHIFT+PrtScn’. Screenshots, in PNG format, 
can be retreived from the Qx via a web browser or SFTP interface.

Note: To successfully take a screenshot, VNC must first be disabled in the ‘Qx Network & Automation‘ 
instrument submenu.   

right-click mouse for additional 
drop-down menus
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Double-clicking within a window will cycle through a set of standard instrument sizes. In many cases, the 
size of a window can be further adjusted to suit requirements. Click and drag on an instrument’s surface to 
reposition the instrument. For instruments with scrolling columns and rows, navigation is further aided by a 
scroll control menu - revealed by right-clicking on the scroll bar.  

About
Selecting ‘About..’ in the Qx ‘Instrument Launch Menu, reveals a window containing information including: Qx 
software version and build, Serial Number; and license, FPGA, and calibration details. 

					   

 
Apply default settings
Applying default settings in the Qx ‘Instrument Launch Menu’ will return the unit’s configuration to its factory 
settings. A user will be asked to confirm this choice via an “Are you sure...” prompt box, before factory 
defaults are restored.  

Switching Mode
A Qx IP or Qx 12G with an IP license, can be run in two different boot up modes: SDI and IP. The Qx 
operation mode is switched via an option in the ‘Instrument Launch Menu’. Depending on the current mode 
of operation the option will be one of the following: 

	 • Switch Mode To IP

	 • Switch Mode To SDI

Selecting ‘Switch Mode To...’ will initiate the switch request. The switch reconfiguration request will take 
approx. 2 mins to complete, during which time the ‘Power Button’ light at the front of the Qx chassis will flash 
yellow.

		                        

The ‘Power Button’ light will become a fixed yellow color (instead of white) once a ‘Configuration on next 
boot’ reconfiguration request is complete; indicating that a mode switch request has been successful. 
Selecting the ‘Reboot’ button will restart the Qx unit in the requested mode.

Powering down the Qx
When the ‘Power Button’ on the Qx is pressed, the unit will shutdown after 10 seconds. To shutdown 
immediately, press the power button again or click the ‘SHUT DOWN NOW’ button that will appear in the 
centre screen shutdown window. To stop shutdown, click the ‘Cancel’ button in the same window.
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Instrument Description
The guide that follows is intended as an introduction to the menu selection and the toolset. The Qx has 
the advantage of being a generator and an analyzer, so this tour of the product will be using both toolsets 
simultaneously.

For this guide we will assume that you have connected the unit to itself as shown in the following diagram 
for SDI or IP optical SFP use.

 211 mm 

 249.3 m
m

 
 44 m

m
 

9.815 "
1.732 "

8.307 "

SDI OUT 
(Generator)

SDI IN 
(Analyzer)

SFP+A 
(IP Receive)

SFP+B 
(IP Transmit)

Connect 
generator to 
analyzer (SDI)

Connect             
IP transmit to    

IP receive (SFP)

 211 mm 

 2
49
.3
 m
m
 

 4
4 
m
m
 

9.
81
5 
"

1.
73
2 
"

8.307 "
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Generation
Generator - Video Standard                                                                  
[Qx 12G / PHQXO-GEN (Qx IP)+PHQXO-UHD  
(for 12G/6G-SDI on Qx IP)]

The ‘Generator - Video Standard’ window is used to select the generator video standard and test pattern. 
Once selected the new test signal is loaded by pressing the ‘Generate’ pane. The Audio Generator can also 
be accessed via the instrument submenu.

Note: In this software revision the pattern may take up to 8 seconds to be generated, after which the eye 
and jitter toolset will be enabled. During this period all other analyzer functions are disabled.

Note: HLG patterns are not included in this release of software

Right-clicking anywhere within the generator window brings up a configuration submenu.

To simplify selection, the generator standards list may be filtered using the following settings:

	 • Filter video standard list > Frame Rate > [No filter, 23.98, 24, 25, 29.97, 30, 47.95, 48, 50, 59.94, 60]

	 • Filter video standard list > Color Format > [No filter, YCbCr:422, YCbCrA:4444, RGBA:4444, 		
	 YCbCr:444, RGB:444, YCbCrA:4224

	 • Filter video standard list > Bit depth > [No filter, 10, 12]

	 • Filter video standard list > Active Lines > [No filter, 720, 1080, 2160]

	 • Filter video standard list > Sub Image Format > [No filter, Single Image, Square Division, 2 Sampl...	
	 erleave]

	 • Filter video standard list > Level > [No filter, A, B]

	 • Filter video standard list > Combined SDI rate > [No filter, 1.5G, 3G, 6G, 12G]

	 • Filter video standard list > Source image width > [No filter, 1280, 1920, 2048, 3840, 4096]

	 • Filter video standard list > Interlace > [No filter, progressive, interlaced, segmented]

	 • Filter video standard list > Link Count > [No filter, 1, 2, 4]

	 • Filter video standard list > Transfer Curve > [No filter, SDR-TV, HLG, PQ]

Filters are removed by selecting in menu:

	 • Filter video standard list > Clear filters
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Test Patterns
The list of available test patterns for a selected video standard is displayed in the right hand column of the 
‘Generator - Video Standard’ window. These patterns include:

100% Bars

Bowtie

Circle – 2 variants

Component Ramps

Grey 10H Step

Grey 5H Step

Grey Steps – 2 variants

Luma Ramp – 4 variants

Pluge – 2 variants

SMPTE 219 sub super

Valid Ramps

75% Bars

Box

Color Grid

Field Lineup

Grey 10V Step

Grey 5V Step

Legal Ramp 

MultiBurst

SMPTE 219/ARIB-28 Bars – 4 variants of each

Tartan Bars

UHD quad Align

For moving test pattern provision, a bouncing box can be overlaid on top of any Generator test pattern. 

	 • Bouncing box >[Enabled, Disabled]
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Pathological signal insertion [SDI Mode]
Pathological Signal Insertion is a powerful feature. 

In addition to selecting a background test pattern, a pathological pattern may be added as an overlay. 

• Pathological insertion > Insertion > [Enabled, Disabled]

Three types of pattern are supported:

	 • Pathological insertion > Pattern to overlay > [Eq, PLL, CheckField]

The amount of pathological pattern may be configured to enable the user to verify how sensitive the SDI link 
is to pathological conditions on the interface:

	 • Pathological insertion > Pairs to insert > [0 to 16384]

This control limits at the selected format’s line length.

Note: Pathological signals are approved by SMPTE for use with HD and 3G Level A standards only. For 
3G Level B, 6G and 12G-SDI interface formats, pathological signals can still be used, but are not approved 
by SMPTE (as of February 2017). It is believed that inserting a full line of pathological signal in these non-
approved standards is too stressful a test for the SDI interface. No physical damage will occur, but the 
interface may exhibit reduced operating performance in the form of bit errors.

Output offset adjustment [SDI Mode]
A signal can be generated with a fixed offset, relative to the system reference.

Offsets can be entered in temporal or spatial terms:

	 • Output offset adjustment > Offset Type > [Time, Lines And Pixels]

Selecting ‘Time’ reveals a drop-down field where the timing offset can be set in microseconds:

	 • Output offset adjustment > Offset Type > Time > Output Time Offset > [0.00, +/- 0.01, etc...]

Selecting ‘Lines And Pixels’ reveals drop-down fields where the offset can be set in coordinate terms:

	 • Output offset adjustment > Offset Type > Lines And Pixels > Output Line Offset > [0 to +/- (Total no. of 
Lines for current standard -1)]

• Output offset adjustment > Offset Type > Lines And Pixels > Output Pixel Offset >[0 to +/- (Total no. of Pixels 
per Line for current standard -1)]

Generator offset is removed by selecting in menu:

	 • Output offset adjustment > Clear offsets
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Generator - Audio                                                                                 
[Qx 12G / PHQXO-GEN (Qx IP)]
32 channel audio generation is available via the instrument submenu accessed via right click. Both a Quick 
config mode for fast setup, and a Custom config mode for bespoke channel setup are provided.

                

The following audio generator settings are available:

	 • Audio Generator > Audio Generator > [Off, Fixed Tone (Quick config), Chromatic Scale (Quick config), 
Custom]

Under the Quick config settings, once the audio generation type is selected, Gain, Gain Type, and Pitch can 
all be configured as required:

	 • Audio Generator > Gain Type > [Fixed Levels, Ramp Levels]

	 • Pitch > [C 3, C♯/D♭ 3, D 3, D♯/E♭ 3, E 3, F 3, F♯/G♭ 3, G 3, G♯/A♭ 3, A 3, A♯/B♭ 3, B 3, C 4, C♯/D♭ 4, D 
4, D♯/E♭ 4, E 4, F 4, F♯/G♭ 4, G 4, G♯/A♭ 4, A 4, A♯/B♭ 4, B 4, C 5, C♯/D♭ 5, D 5, D♯/E♭ 5, E 5, F 5, F♯/G♭ 5, G 5, 
G♯/A♭ 5, A 5, A♯/B♭ 5, B 5, C 6, C♯/D♭ 6, D 6, D♯/E♭ 6, E 6, F 6, F♯/G♭ 6, G 6, G♯/A♭ 6, A 6, A♯/B♭ 6, B 6, C 7]

When the Fixed Levels gain type is selected, gain can be adjusted in decibels relative to full scale (dBFS):  

	 • Audio Generator > Gain > [-144 to 0] 

Greater flexibility in configuration is provided when the Audio Generator Custom setting is chosen. Custom 
config allows for the selection of the specific number of audio groups required; and then, the setting of 
frequency in hertz and gain level, for each channel individually:

	 • Audio Generator > Audio Generator > Custom > Num Groups > [1 to 8 (dependent on selected 		
	 standard)]

	 • Audio Generator > Audio Generator > Custom > Channel > [0 to 31 (dependent on selected 		
	 standard)]

The audio channel frequency can entered by keyboard or via the onscreen keypad:

	 • Audio Generator > Audio Generator > Custom > Channel > Frequency (Hz) > [0 to 24000]

Gain can be adjusted in decibels relative to full scale (dBFS):  

	 • Audio Generator > Audio Generator > Custom > Channel > Gain > [-144 to 0]

To apply the config of the currently selected channel to all channels, choose:

	 • Apply to all channels 
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Generator - Status                                                                                 
[Qx 12G / PHQXO-GEN (Qx IP)]

The ‘Generator - Status’ menu shows the generator pattern selected, and confirms the SFP output (IP Mode) 
or SDI OUT A, B, C, D (SDI Mode) presence, and Sub Image/Full Image mapping information. It also confirms 
Video Standard, Test Pattern, and Reference details. This window provides status information only; there are 
no user settings to configure. 
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System
SFP IP Network                                                                                      
[IP Mode]

The ‘SFP IP Network’ window provides an overview of the status of the Qx SFP interfaces used for 2022-6 
IP packet transmission and reception. IP receive (A) and transmit (B) SFP presence, carrier signal presence, 
interface status, SFP MAC and IP addresses, and packet information are displayed here. Error status 
information is displayed at the bottom of the window. 

Right-clicking in the window reveals a submenu, from where the static IP address, and network/subnet mask 
of each SFP can be set, by keyboard or onscreen Keypad.

Static IP address of SFP:

	 • SFP...IP addr and mask > [set IP address of SFP as required]

Mask selection is via a drop-down menu. Classless Inter-Domain Routing (CIDR) notation is used; with a 
default value of /24 (i.e: 255.255.255.0):

	 • SFP...IP addr and mask > [set mask in drop-down, 30 to 8]

Default Gateway:

	 • SFP...Gateway IP Addr > [set Gateway IP address as required]

IP settings are saved by selecting:

	 • Apply SFP...Static IP Parameters



PHABRIX Qx User Manual Page 14

Generation
IP Transmit (SFP B)                                                                         
[PHQXO-IP-NGT+PHQXO-IP-ENC+PHQXO-GEN (Qx IP)]

The ‘IP Transmit (SFP B)’ window is used to transmit the currently generated video standard signal as IP 
video packets. 

The tool can be used to simulate IP video network packet jitter introduced under a variety of network 
conditions by providing the ability to adjust the transmission distribution profile. 

The histogram shows the interval timing distribution of the packets being generated (each second) - that is: 
the number of packets being generated each second, against the deviation of each packet interval from 
the expected interval time. Transmission status information and prompts are also displayed at the bottom 
of the window, and hovering over this status information reveals a tooltip detailing the ‘Current Transmit 
Parameters’.

Right-clicking in the window reveals a submenu.

Packet transmission can be switched on and off:

	 • Transmit > [On, Off]

The type of distribution profile can be selected, and the range of transmission packet intervals can be 
adjusted. The adjustments are displayed in real-time, in the transmission histogram. 

	 • Distribution Range > [slider +/- 0...492 clks]

	 • Distribution > [Uniform, Gaussian]

The submenu also provides the option to plot the number of transmitted packets on the vertical axis, in 
either linear or logarithmic scale:

	 • Y-Axis Scale > [Linear, Log10]

Network Settings
IP, UDP, and SSRC network settings for packet transmission are set in the submenu, and can be entered by 
keyboard or via the onscreen keypad when ‘Transmit’ is ‘Off’.

Transmission can be either multicast or unicast. The multicast group destination IP address, or the IP address 
of the receive device (in the case of unicast) should be set as the destination IP address; as required:

	 • Dst IP Addr > [set IP address]

The destination MAC address should be set as required, to ‘Automatic’ for multicast, or ‘SFP A’ for unicast 
transmission to the same Qx unit. For unicast transmission to another device, set to ‘Manual’, and then enter 
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below the MAC address of, the receive device (in the case of a direct connection) or the first switching 
device in the path of the transmitting Qx (in the case of an indirect connection to the receive device).

	 • Dst MAC Addr > [Automatic, Manual, SFP A]

UDP parameters:

	 • Src UDP Port > [set UDP port number as required]

	 • Dst UDP Port > [set UDP port number as required]

A Synchronization source identifier (SSRC) can be set for RTP stream subscription if required:

	 • SSRC > [set ID if required]

Once required network settings have been entered, switch ‘On’ ‘Transmit’ to commence transmission.

Note: Ensure also, that you are generating a test signal for transmission in ‘Generator - Video Standard’. 

System
SFP (A, B) - Info                                                                                      
[IP Mode]

            		         

The ‘SFP - Info’ windows gives at-a-glance physical status information on each Qx SFP module, including 
Identifier, Connector, line code (Encoding), Vendor details and approval status for use with the Qx. More 
detailed status information for the SFP, such as temperature and voltage are also displayed.

Temperature and Power display units can be adjusted via the right-click submenu:

	 • Temperature Units > [°C, °F]

	 • Optical Power Units > [mW, dBm]
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System
System IO

SDI Mode
Due to the complexity of the UHDTV standards, PHABRIX has introduced innovative ways of displaying 
status. The ‘System IO’ window has been designed as a quick view of the signal inputs and outputs attached 
to the Qx.

Active SDI inputs and outputs are indicated by the colored connectors. An entirely greyed out connector 
indicates that a signal is not present, and the previously colored ring will be black. The color of the 
connectors correspond to the color of their related instrument borders and instrument icons, to aid 
recognition. 

The presence of external reference and its standard, is also displayed graphically with a colored connector. 
If the system is set to lock to the external reference, and a stable lock has been achieved, then the inner 
ring of the ‘EXT REF’ BNC pictured, will be highlighted in grey. The following ‘EXT REF’ BNC colors relate to 
various external reference status:   

	 • Grey (reference connected), Red (error with reference), Black (no reference connected]

Note: The EXT REF BNC shows the status of external reference only; which is not necessarily the system 
reference. Overall system reference is selectable in the ‘Timing and System Reference’ instrument window.

Below the graphical connector display, is a table showing input and output status, and external reference 
standard and status. The external reference field displays the following states:

	 • EXT REF: [No Signal, Unstable, 525/59.94, 625/50, etc...]

If external reference is not currently being used as system reference, its field text will display in yellow. When 
external reference is the system reference, this table field text will be white.

IP Mode
Active SFP receive inputs and transmit outputs are indicated by colored connectors. The color of the 
connectors corresponds to the color of their related instrument borders and instrument icons, to aid 
recognition.

An entirely greyed out connector indicates that a signal is not present. If an SFP is unseated or not present, 
this is displayed graphically with a black void - indicating a missing SFP.

SFP presence is shown in a table that also contains external reference standard and status details; as per 
the SDI version of this UI.
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Analysis
Analyzer - Video Standard

	          

The ‘Analyzer - Video Standard’ window displays the payloads of the video standard being analyzed. It lists 
the payloads on SDI (SDI Mode) / 2022-6 (IP Mode) input signals.

The Payloads are identified primarily by ST-352 packets, if these are missing the signal stats will be analyzed 
and a best guess payload identifier will be listed.

Payloads with incorrect ST 352 packets are indicated in red within the ‘Analyzer - Video Standard’ window.

	 • Ignore Payload Identifier Packets (ST 352) > [Enabled, Disabled]

ST-352 packets can be ignored such that a best guess payload identifier is always used. This is done by 
selecting ‘Enabled’ in the ‘Ignore Payload Identifier Packets (ST-352)’ submenu option.

Payloads with ignored ST 352 packets are indicated in red within the ‘Analyzer - Video Standard’ window.
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Analysis
Stats - SDI In A, B, C, D                                                                         
[SDI Mode]
‘Stats - SDI In A’, B, C and D provide information to verify the format of the signals being analyzed. A video 
signal may be comprised of up to four separate SDI signals, hence four separate windows.

Example 1 shows the display of data from a single 12G input on input A

Example 2 shows the display of data from a quad 3G input - hence 4 separate video status windows
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System
IP Receive - Stream Select (SFP A)                                                        
[Qx IP / PHQXO-IP-DEC (Qx 12G)]

The ‘IP Receive - Stream Select (SFP A)’ window is where a stream can be selected for reception. An IP 
video source can be switched here easily. Multicast requests can be setup and cancelled via the submenu.  

The instrument provides a list of all available streams - both multicast and unicast. For each stream, details 
including: IP video protocol, IP address, UDP port and SSRC information are all displayed; and video format 
information for the selected stream, stored at the IP level, is summarized in the ‘Receive Src IP’ pane.

Once selected, a new stream is received by pressing the ‘Receive Src IP’ pane. 

The instrument window will indicate which stream the analyzer is currently locked to.

The submenu, accessed by right-clicking within the ‘IP Receive - Stream Select (SFP A)’ window calls up 
multicast setup, SSRC receive conditions, and list clearing controls.

The displayed list of available streams can be cleared by selecting:

	 • Clear input list

Where an SSRC ID is included in an available stream, the tool can be set to only receive a stream with an 
‘Exact’ ID match, or one with ‘Any’ value.

	 • SSRC match > [Exact, Any]

Multicast Setup
Streams can be accessed via an IGMPv2 or v3 multicast request. The details of the multicast to be joined 
must be entered first. The destination IP address of the multicast can entered into the destination IP address 
fields by keyboard or via the onscreen keypad:

	 • Multicast req: Dst IP addr > [224.0.0.1...239.255.255.255]

Streams transmitting on this multicast will be listed in the instrument window.

To join a multicast:

	 • Request Multicast

To exit a multicast:

	 • Leave Multicast

IP
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System
IP Receive - Interpacket Timing (SFP A)                                           
[PHQXO-IP-NAT+PHQXO-IP-DEC (Qx 12G)]

The instrument provides analysis of IP media packet reception, and gives a real-time indication as to the 
health of the received signal. 

The histogram displays the distribution of all packet arrival intervals within a given second - the mean, 
minimum, and maximum packet intervals for this period are also displayed. Outlier times significantly longer 
than the expected mean, indicate significant delays in packet propagation. A high occurrence of such long 
intervals characterises high jitter in a network.

Right-clicking reveals a submenu with the option to plot the number of received packets on the vertical axis, 
in either a linear or logarithmic scale:

	 • Y-Axis Scale > [Linear, Log10]

System
Stats - IP Receive (SFP A)                                                                 
[PHQXO-IP-NAT+PHQXO-IP-DEC (Qx 12G)]

‘Stats - IP Receive (SFP A)’ provides information to verify the format of the signal being analyzed.
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Analysis
Analyzer - Picture 

The picture view shows the generator pattern currently being analyzed by the Qx. Double-click within the 
window to resize it between 1/16 of a screen, 1/4 screen, and full screen.

Blanking Area
In the right-click submenu, the user can enable ‘Show Blanking’. This will offset the picture to the right, 
revealing the blanking area.

	 • Show Blanking > [Enabled, Disabled]

Note: ‘Show Blanking’ is not available for multiple sub-image video standards as the active picture is 
separated from the blanking regions during active picture reconstruction.
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Picture Cursor
With Picture Cursor enabled, a specific line and pixel position can be selected in the picture. This feature 
is dynamically linked to both the Wavefrom and Dataview instruments; so measurements from the selected 
picture position can be taken from these tools at the same time. 

	 • Picture Cursor > [Enabled, Disabled]

	 • Picture Cursor > Enabled > Line > [1 to Total no. of Active Lines for current standard]

	 • Picture Cursor > Enabled > Pixel > [0 to (Total no. of Active Pixels for current standard -1)]

Note: Keep in mind when using Dataview in conjunction with the Picture and Waveform instruments that the 
Dataview includes horizontal blanking, and so uses transport line numbers, not active picture line numbers.

Note: ‘Picture Cursor’ is unavailable when ‘Show Blanking’ is enabled.

HDR Heat-map (False Color Overlay) [PHQXO-HDR]
A false color overlay can be applied to the picture view, to highlight luminance ranges of the image that are 
of particular interest be they High Dynamic Range (HDR) or otherwise.

The picture can be displayed in greyscale. If enabled at the same time as ‘False Color Highlighting’, all 
image elements outside of the enabled false color overlay luminance range(s) will be displayed in greyscale 
mode; leaving the false color highlight elements to stand out more:

	 • Greyscale mode > [Enabled, Disabled]

Different types of false color overlay may be applied to clearly visualize different image details, and a custom 
mode is provided to allow the creation of a modified or bespoke overlay:

	 • False color ranges > False Color Highlighting > [Disabled, PQ HDR, SDR All Bands, SDR Shadow, 
SDR Skin Tones, SDR Highlights, Out of Range, Custom]

The range(s) and colors of a selected false color overlay can be modified by adjusting the 7 overlay bands. 
Up to 7 distinct ranges can be simultaneously enabled in a single overlay. If adjusted, the new or modified 
overlay will be designated as the ‘Custom’ overlay type.

		      

When False Color Highlighting is enabled, a scale with numeric and graphic display of the luminance 
range(s) of the overlay in use, is available:

	 • False Color Overlay Scale > [Enabled, Disabled]

The required luminance units for the scale can be selected:

	 • Luminance Measurement > [Decimal Level, PQ Nits]
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Transfer Curve and Colorimetry Overrides [PHQXO-HDR]
HDR content may still contain the SMPTE payload ID for SDR and Rec.709 colorspace (as ‘standard’). 

Therefore, for accuracy, when analyzing most known HDR and WCG (Wide Color Gamut) content, overrides 
can be enabled for the appropriate HDR transfer curve, and for WCG color space:

	 • Enable Transfer Curve Override > [Enabled, Disabled]

	 • Transfer Curve Override > [SDR-TV, HLG, PQ]

	 • Enable Colorimetry Override > [Enabled, Disabled]

	 • Colorimetry Override > [Rec.709, Rec.2020]

Sub Image Pixel Mapping Format Override
Where sub image format signals are delivered without ST-352 packet payload IDs or with mislabelled sub 
image mapping information, e.g. if 2 sample interleave (2-SI) signal content is delivered incorrectly as square 
division (SQ), it is important to be able to override the erroneous mapping in order to display the content 
correctly.

	 • Enable Sub Image Pixel Mapping Format Override > [Enabled, Disabled]

	 • Sub Image Pixel Mapping Format Override > [2 Sampl...erleave, Square Division]

Note: The resulting effects of enabled overrides will be reflected in other image analyzer instruments within 
the Qx Analyzer instrument toolset.
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Analysis
Analyzer - CIE Chart                                                                       
[PHQXO-HDR]

The CIE 1931 x y chart provides a display of signal chromaticity - complete with Rec. 709, Rec. 2020, ST 
2086 gamut overlays and the Illuminant D65 white point reference. 

CIE Chart setup is accessed by right-clicking within the chart area:

	 • Rec. 709 Triangle > [Enabled, Disabled]

	 • Rec. 2020 Triangle > [Enabled, Disabled] 

	 • ST 2086 Triangle > [P3, Disabled] 

	 • D65 White Point > [Enabled, Disabled]

	 • Single Line Mode > [Enabled, Disabled]

	 • Zoom > [slider 1.00...4.00]

	 • Zoom > x Position > [slider, left to right]

	 • Zoom > y Position > [slider,  bottom to top]

	 • Brightness > [slider 1..31]

	 • Gamma > [slider 1..255]

	 • Persistence [slider 1..255]

Zoom can also be performed by hovering the mouse crosshairs over the chart and scrolling the mouse 
wheel. Panning, in the x and y axes can also be performed by hovering the mouse crosshairs over the axis in 
question and scrolling the mouse wheel. 
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Analysis
Analyzer - Waveform

The Waveform instrument provides various analysis settings including Single Line Mode and Picture Cursor 
control. 

When Picture Cursor is enabled, the cursor is dynamically linked to the cursor in the Picture instrument, and 
to Dataview navigation. Clicking the cursor in a new position in the Waveform window updates the pixel 
and active picture line position selected in the Picture instrument, and the pixel and transport line position 
selected in Dataview.

Waveform setup is accessed by right clicking within the waveform area:

	 • Parade Mode > [YCbCr, Y, Cb, Cr, RGB, GBR, YRGB, YGBR, Red, Green, Blue]

	 • V Scale > [Percent, Hex Value, Decimal Value, Millivolts, Nits]

	 • H Scale > [Pixels, % Line]

	 • Filter > [Flat, Low Pass, Raw]

	 • Single Line Mode > [Enabled, Disabled]

	 • Single Line Mode > Enabled > Line Number > [1 to Total no. of Lines for current standard]

	 • Picture Cursor > [Enabled, Disabled]

	 • Picture Cursor > Enabled > Pixel Number > [0 to (Total no. of Pixels for current standard -1)]

	 • Rec. 2408 Diffuse White Marker > [Enabled, Disabled]

	 • H Magnification > [slider 1.00...10.00]

	 • H Magnification >H Position > [slider, left to right]

	 • V Magnification > [slider 1.00...4.00]

	 • V Magnification > V Position > [slider,  bottom to top]

	 • Brightness > [slider 1..31]

	 • Gamma > [slider 1..255]

	 • Persistence [slider 1..255]

	 • Monochrome Mode [Enabled, Disabled]
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Analysis
Analyzer - Vectorscope

Vectorscope setup is accessed by right clicking within the vectorscope area:

	 • Targets > [Off, 75%, 100%]

	 • I/Q Axes > [Off, I Only, Q Only, Both]

	 • Filter > [Flat, Low Pass, Raw] 

	 • Centre > [Origin, Red, Green, Blue, Magenta, Cyan, Yellow]

	 • Single Line Mode > [Enabled, Disabled]

	 • Single Line Mode > Enabled > Line Number > [1 to Total no. of Lines for current standard]

	 • Zoom > [slider 0.50...4.00]

	 • Brightness > [slider 1..31]

	 • Gamma > [slider 1..255]

	 • Persistence [slider 1..255]
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Analysis
Eye - SDI in A                                                                               
[PHQX01E / PHQX01E-IP / PHQXM-01E]
One of the unique features of the Qx is the PHYSICAL layer analysis toolset. The Qx contains fundamental 
technology developed and patented by PHABRIX which makes it unique where physical layer compliance 
measurements are required up to 12 Gbps. 

The Qx employs an analog front end providing in excess of 30 GHz bandwidth (5th harmonic of the 6GHz 
fundamental for 12G-SDI). Featuring PHABRIX Real-Time Eye RTETM  technology the Qx is in a league of its 
own. More akin to expensive high end oscilloscopes, the Qx provides broadcast engineers with a reliable, 
instantaneous physical layer display with automatic measurements to SMPTE standards.  

The Qx enables measurement of both overshoot and undershoot along with amplitude, rise time, fall time 
and delta - compulsory when testing against SMPTE standards. Accurate measurements are obtained within 
seconds of connecting an SDI signal, making for a very fast system testing solution. Out of specification 
measurements are indicated in red.

Example 1: 12G-SDI Eye pattern display with 100 kHz jitter filter

Example 2: 3G-SDI Eye pattern display with 100 kHz jitter filter

Note: ‘SDI In A’ has a red nut to indicate it is the SDI BNC that has the eye and jitter circuitry behind it
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The Physical Layer tool-set has several drop-down menus selected by a right click of the mouse.

(A table showing the SMPTE tolerances for each standard is available at the end of this manual.)

Selections include:

	 • Eyes > [1, 2, 3...20]

	 • Color > [Green, Heat, Red, Ferrara, Green-red, Blacklight]

	 • Eye and jitter filter > [10Hz, 100Hz, 1kHz, 10kHz, 100kHz]

	 • Infinite mode >[Enabled, Disabled]

The display also provides: 

	 • Timing jitter thermometer color coded according to analysed SDI standard

	 • Alignment jitter thermometer color coded according to analyzed SDI standard

	 • On screen indication of 20% and 80% levels for rise and fall time measurement

	 • On screen indication of +10% and -10% levels for overshoot and undershoot analysis

	 • Positive and negative amplitude values providing DC offset information

	 • Horizontal histogram of eye crossing point (0mV threshold)

	 • Vertical histogram providing indication of energy distribution over all samples
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Analysis
Jitter - SDI In A  [PHQX01E / PHQX01E-IP / PHQXM-01E]

The jitter tool-set is available on the ‘SDI In A’ BNC (the one with the red nut)		

The jitter instrument shows automated measurements to SMPTE standards.

Readings for each of the filters are shown displayed as an overlay on the right hand side of the instrument. 

Any red text displayed indicates an out of specification reading.

As with the Eye instrument, further drop-down menus are available using the right click on the mouse 
control:

	 • Scale > [sliding scale: Y graticule adjustment from +/- 0.2 UI to +/-8UI]

	 • Trigger > [None, Single Line, Two Lines, Single Field, Two Fields, Frame]

	 • Eye and jitter filter > [10Hz, 100Hz, 1kHz, 10kHz, 100kHz] 

	 • Infinite Mode > [Enabled, Disabled]

	 • Jitter Color > Waveform color selection

Color selection is via a HSV tool providing two cursors. The left hand color rectangle allows selection of hue 
(horizontal) and saturation (vertical). The right hand vertical bar selects color lightness.

Trigger modes are useful for correlating jitter content to line and frame rate frequencies.
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Analysis
Analyzer - Dataview

This instrument presents the raw data present in the signal be it 1.5G HD-SDI, 3G-SDI, 6G-SDI, 12G-SDI or 
2022-6.  The data can be observed in hexadecimal, decimal or binary formats and the data is navigated 
by pixel and line selection. The instrument displays the entire video frame complete with active video, TRS 
words and blanking information. 

By right clicking using the mouse on this instrument, the following drop-down menus are presented:

	 • Sample > [slider 0 to max_pix_count]

	 • Line > [slider 0..max_line_count]

	 • Navigate > [calls up navigation pane - see below]

	 • Base > [hex, decimal, binary]

	 • Field > [Field 1, Field 2] (standard dependant)

	 • Sub-Image > [Sub Image 1, Sub Image 2, Sub Image 3, Sub Image 4] (standard dependant]

Data is presented with a color coding for both text and 
background:

	 • Foreground color indicates video sample type: Y (white), 	 	
	 Cb (blue), Cr (red)

	 • Background color indicates data type: TRS words (blue), 	 	
	 Blanking (black), Active picture (green)

Changing the window size changes the amount of data 
displayed.

A navigation keypad activated by selecting ‘Navigate’ on the 
top bar of the instrument allows the user to quickly navigate the 
dataview window.
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Analysis
Video Timing and System Reference

The upper part of the instrument view is devoted to ‘SDI A vs System Reference’ timing comparison 
(‘Decapsulated vs Reference’ in IP Mode); and system reference is set in the instrument submenu. 

The lower part displays SDI Co-timing information for elements of a quad or dual link signal.

System Reference Lock
The submenu accessed by right clicking within the ‘Video Timing and System Reference’ window calls up 
system reference locking controls; defining the reference that the Qx system and any signal it generates will 
be locked to:

	 • System Reference > [Free Run, External Reference, SDI (SDI Mode only)]

	 • Default To Freerun > [Enabled, Disabled]

System reference status information is displayed in the upper right hand corner of the instrument, and any 
reference health state error will be displayed in red.

SDI A vs System Reference / Decapsulated vs System Reference
This section of the instrument displays the timing difference between the SDI A input signal (or 
Decapsulated input - IP Mode) and the system reference the Qx is locked to. Both graphic and numeric 
(spatial and temporal) values are presented by the instrument for this measurement. A relative timing bar tool 
dynamically measures the timing of the input (white triangle) against the system reference (centrally fixed 
black vertical crosshair). 

The tool can be adjusted to display readings at frame scale, or zoom in all the way to a fraction of a line: 

	 • Reference Timing Meter Range > [+/- 0.1 line, +/- 0.5 line, +/- 0.5 frame]

Input Measurement Offset
In addition to measurement of the input against absolute system reference, a system reference offset can 
also be applied in the tool to measure against. The offset position is indicated on the relative timing bar tool 
with a black triangle.

Offsets can be entered in temporal or spatial terms:

	 • Input Measurement Offset Type > [Time, Lines And Pixels]

Selecting ‘Time’ reveals a drop-down field where the timing offset can be set in microseconds:

	 • Input Measurement Offset Type > Time > Input Measurement Time Offset > [0.00, +/- 0.01, etc...]



PHABRIX Qx User Manual Page 32

Selecting ‘Lines And Pixels’ reveals drop-down fields where the offset can be set in these terms:

	 • Input Measurement Offset Type > Lines And Pixels > Input Measurement Line Offset > [0 to +/- (Total 	
	 no. of Lines for current standard -1)]

	 • Input Measurement Offset Type > Lines And Pixels >Input Measurement Pixel Offset > [0 to +/- (Total 	
	 no. of Pixels per Line for current standard -1)] 

The input measurement offset can be set to the same position as the current ‘SDI In A’ (or ‘Decapsulated’ - IP 
Mode) signal:

	 • Set Input Measurement Offset to current

The input measurement offset is removed by selecting in menu:

	 • Clear Input Measurement Offset

SDI Co-Timing [SDI Mode]
Many of the standards associated with UHDTV are a combination of signals to form the image plane. 
Relative timing tools indicate that the quad or dual elements creating the single picture are correctly aligned 
and compared with reference. Both graphic and numeric values are presented by the instrument for this 
critical measurement. Any red text displayed indicates an out of specification measurement.

Note: The Timing instrument in this software release is locked to Input A.

Analysis
Analyzer - Ancillary Status

The Qx has a sophisticated display to analyze ancillary data in the signal. UHDTV has a new set of rules for 
carrying this data. The clear graphical representation of this is required to establish compliance. Color coded 
signal conditions - present, lost, and error are all available. Additional data is displayed as the instrument is 
resized.

	 • White - Indicates ANC packets present and correct

	 • Red - Indicates ANC packets present but in error

	 • Yellow - indicates ANC packets present and correct but there has been a previous error

Status is reset by selecting in menu:

	 • Reset
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Analysis 
Analyzer - Audio Meters

The ‘Analyzer - Audio Meters’ instrument displays 16 x audio meters along with peak level indication and 
audio pair phase indication. In addition dBFS values are indicated at the base of each meter. 

Dolby E, D and D+ streams are detected by the system with Dolby stream indication in blue.

The HDMI instrument output carries a stereo pair of audio, as does the SDI instrument output. The same 
signal is made available on the 26-way D-type at the rear of the Qx chassis.

Stereo pair monitoring selection is provided by selecting the speaker icon above each set of audio meters. 
Mono channel selection is provided by selecting the appropriate solo bus located between the audio 
meters and the speaker icons.

Menu options provided:

	 • Input Select > [Image/Sub-Image 1 Group 1-4, Image/Sub Image 1 Group 5-8, Sub-Image 2 Group 1-4, 	
	 Sub-Image 2 Group 5-8, Sub-Image 3 Group 1-4, Sub-Image 3 Group 5-8, Sub-Image 4 Group 1-4, 	
	 Sub-Image 4 Group 5-8] 

	 • Ballistics > [PPM Type I, PPM Type II, Vu, VuFr]

	 • PPM Scale Type > [dBFS, dBu -18dBFS, dBu-20dBFS, BBC, DIN45406, NordicN9]

	 • Hat Hold Time > [0.00...10.00, infinity]

	 • Monitor Buttons > [Enabled, Disabled]

	 • Solo Buttons > [Enabled, Disabled]

Up to two audio meter instrument windows can be enabled providing 32 simultaneous channels of audio 
metering. Each window is assignable to monitor groups 1 to 4 (defined in SMPTE ST 299-1) or groups 5 to 
8 (defined in SMPTE ST 299-2) in any of up to 4 potential sub-image ANC areas as defined in SMPTE ST 
2082-10.

Each audio window is scalable from 1/32 to 1/4 of screen area.
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Analysis
Analyzer - CRC Analysis

The ‘Analyzer - CRC Analysis’ window checks for CRC errors in the signal. Dependant on the input required 
for the standard under test, i.e. 4 inputs or single, the Sub Image columns will show any errors in each of the 
inputs attached.

The ‘Last error timer’ event shows in seconds the last CRC error event in each input.

In addition, a separate timer indicates the time since error checking began.

The instrument also analyses the CRC of the overall active picture to detect changes.

	 • Reset errors and running time
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System
SFP (A, B) - Network Stats [A: PHQXO-IP-NAT+PHQXO-IP-DEC (Qx 12G);                                                                                   
B: PHQXO-IP-NGT+PHQXO-IP-ENC+PHQXO-GEN (Qx IP)]

The Network Stats window displays transmission and reception traffic information, detailing the type and 
number of packets sent and received by an SFP. CRC errors are identified and packet sequence errors 
reported. Double-clicking the window expands it, to reveal additional packet information.

 
Event Logging

Logging is provided on the Qx, and logs can be viewed in ‘Event Logging’. The Qx allocates 500 lines for 
logging detail before overwriting this data. It will also recall the log data last captured if the unit is started 
from cold. The setting for logging data will need to be re-entered from a cold start using the right click 
selection. Logs can also be accessed and saved via the REST API.

SDI Mode
By right clicking the mouse on this instrument the following drop-down menus are presented:

	 • Record Jitter Timing Logs > [Enabled, Disabled]

	 • Record Jitter Alignment Logs > [Enabled, Disabled]

	 • Record SDI Input Standard Logs > [Enabled, Disabled]

	 • Record SDI Input Rate Logs > [Enabled, Disabled]
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	 • Record REST API Request Logs > [Enabled, Disabled]

	 • Record Reference Locking Logs > [Enabled, Disabled]

	 • Clear logs

IP Mode
By right clicking the mouse on this instrument the following drop-down menus are presented:

	 • Record Reference Locking Logs > [Enabled, Disabled]

	 • Record IP Tx Logs > [Enabled, Disabled]

	 • Record IP Rx Logs > [Enabled, Disabled]

	 • Record IP Interfaces Logs > [Enabled, Disabled]

	 • Record SFP Logs > [Enabled, Disabled]

	 • Clear logs

Event logging will be developed further in future software releases.

System
Qx Network & Automation

The Qx can be controlled remotely in a number of ways including via VNC, and via REST API which can be 
used for automated testing. The IP address of the Qx can be dynamically assigned on a DHCP enabled 
network, or a static IP address can be set.

From the ‘Qx Network & Automation’ window, VNC can be enabled in the submenu:

	 • VNC Server > [Disabled, Enabled]

The VNC Server setting will shows the number of current VNC connections to the Qx. Once a connection is 
made, this number will be updated. For more details on VNC setup, see ‘Remote Connection’ section of this 
manual.

From the ‘Qx Network & Automation’ window a REST API remote connection can be established by enabling 
‘REST API’ in the submenu: 

	 • REST API > [Disabled, Enabled]



PHABRIX Qx User Manual Page 37

The ‘Qx Network & Automation’ window contains all the information on the Qx that is needed in order to 
send it a REST request. ‘IP Address’ (or ‘mDNS Hostname’ if your client’s host supports it) should be used as 
the recipient of the request, and ‘REST API Port’ is the port that requests will need to be directed towards.

Note: The mDNS Hostname is composed of qx-<serial number>.local e.g qx-123456.local and is insensitive 
to case

The REST API supports three HTTP methods: GET, PUT, and DELETE. 

GET requests can be used to retrieve Qx information and navigate the submenus. PUT requests can be 
used to modify and control Qx behaviour and actions. 

A web browser can be used to retrieve Information from the Qx with GET requests. 

Any HTTP/1.1 compliant application can be used to control the Qx with both GET and PUT requests.

PUT, GET, and DELETE requests can be scripted for automated testing.

REST API Requests
For the following REST API request examples, an example IP address (192.168.0.142) and default REST API 
Port (8080) are used. The base resource to aim requests at is “/api”. The base URL for requests (GET) will be 
in the format: http://192.168.0.142:8080/api or http://qx-020094.local:8080/api

REST API requests can be used to:

	 • Report the current analyzed standard (GET): http://192.168.0.142:8080/api/v1/analyser/status

	 • Report the currently generated standard (GET): http://192.168.0.142:8080/api/v1/generator/status

	 • Navigate through list of available generator standards (GET): http://192.168.0.142:8080/api/v1/		
	 generator/standards. Select from tree and GET again to drill down to appropriate color format, bit 	
	 depth, level, SDR or HDR format, and test pattern.

	 • Generate a standard (PUT): http://192.168.0.142:8080/api/v1/generator/				  
	 standards/1920x1080p60/YCbCr%3A422%3A10/3G_A/100%25%20Bars. 

	 A pathological overlay, its type and number of pairs can be added by including a raw payload of, for 	
	 example, {“action”:“start”,“pathological”:{“type”:“CheckField”,“pairs”:100}}

	 • Report the currently generated audio standard (GET): http://192.168.0.142:8080/api/v1/generator/	
	 audio

	 • Audio generation (PUT): http://192.168.0.39:8080/api/v1/generator/audio. Including a raw payload 	
	 for Quick config, of the structure, for example, {“mode”:”Fixed Tone”,”quickConfig”:{“gainType”:”Fixed 	
	 Levels”,”gain”: -10,”pitch”: “E 3”}}. For Custom config raw payload structure, refer to the GET request 	
	 output structure.

	 • View instantaneous Eye readings (GET): http://192.168.0.142:8080/api/v1/eye/status

	 • View instantaneous Jitter readings (GET): http://192.168.0.142:8080/api/v1/jitter/status

	 • Retrieve the event logs (GET): http://192.168.0.142:8080/api/v1/eventlog/logs

	 • Report current CRC analysis status (GET): http://192.168.0.142:8080/api/v1/analyser/crcSummary

	 • Manage the event logs (PUT): http://192.168.0.142:8080/api/v1/eventlog/config/restAPI with a raw 	
	 payload of {“action”:“enable”} in this example, to enable REST API event logging.

Specifically in IP Mode, REST API requests can be used to: 

	 • Report the currently active multicast request (GET): http://192.168.0.142:8080/api/v1/ipReceive/		
	 multicastRequests

	 • Request a new multicast (PUT): http://192.168.0.142:8080/api/v1/ipReceive/multicastRequests with 	
	 a raw payload of the form {“action”:“request”,“destinationIpAddress”:”230.0.0.15”} in this example, to 	
	 join a multicast group of destination IP address 230.0.0.15
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	 • Report list of currently available IP media streams (GET): http://192.168.0.142:8080/api/v1/ipReceive/	
	 mediaStreams

	 • Select IP media stream for analysis (PUT): http://192.168.0.142:8080/api/v1/ipReceive/			 
	 mediaStreams with a raw payload of the form {“action”: “analyseStream”,“destinationIpAddress”: 	
	 “230.0.0.15”,“destinationUdpPort”: 10000,“matchSsrc”: true,“sourceIpAddress”: 				  
	 “192.168.25.2”,“sourceUdpPort”: 10000,“ssrc”: 123456}

	 • Report the IP media stream currently being analyzed (GET): http://192.168.0.142:8080/api/v1/		
	 ipReceive/requestedmediaStreams

	 • Clear list of IP media streams (PUT): http://192.168.0.142:8080/api/v1/ipReceive/mediaStreams with a 	
	 raw payload of {“action”:“clearList”}

For full details of all available Qx REST API requests, see the Qx REST API documentation available at:

IP Rest API - https://phabrix.com/api/qxip.html

12G Rest API - https://phabrix.com/api/qx12g.html 

  

System
Time and NTP

			         

By ‘right clicking’ the time displayed on the right hand side of the menu bar, a separate window will be 
displayed. Use the slider control to select the required time zone:

NTP can be turned off which will then provide manual control of time setting. To return to NTP use the 
mouse to select the ‘Automatic’ feature.

	 • Time Zone > [select zone]

	 • Set Time & Date > Automatic [check box]

	 • Set Time & Date > Update Now [press to update]

	 • NTP Server: > [eg. pool.ntp.org]

https://phabrix.com/api/qxip.html
https://phabrix.com/api/qx12g.html 
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System
Driver Calibration                                                                              
[PHQX01E / PHQX01E-IP / PHQXM-01E]

			         

Note: All PHABRIX units are calibrated and verified prior to dispatch. Over time however, the SDI generator 
outputs of the Qx may require recalibration. 

On units with PHABRIX RTE™ (Real Time Eye) capability (PHQX-01E only), the SDI generator outputs of the Qx 
can each be calibrated using the SDI A Input of the Qx.

Note: Recalibration relies upon the calibration status of the Eye/Jitter analyzer. If in doubt consider returning 
the unit to PHABRIX for calibration.  

Warning: Before attempting Qx calibration, be sure to that you are using a 12G cable of the specification 
described below. If in doubt, do not attempt to perform calibration on your unit.

SDI Output Calibration Steps
Calibration can be performed by first, connecting a 1metre long cable between SDI A Input and the SDI 
Output to be calibrated. A 12G-SDI grade or compatible cable with 12G-SDI BNCs must be used. Suitable 
cable types include:  Canare L-5.5CUHD, and Belden 1694A.

Next, from the ‘Instrument Launch Menu’, selecting ‘System Settings > Driver Calibration’ opens a calibration 
window. 

A drop-down menu allows the selection of the output to be calibrated. For SDI Output A, select Driver A, etc. 

Select ‘Start’ to begin calibration. The calibration of an output should take 2-5 minutes.

Once SDI Output A is calibrated, connect the output side of the cable to SDI Output B and repeat the 
process outlined above, until all Qx SDI Outputs have been calibrated.

			         

It may take approximately 20 minutes to calibrate all four outputs. 
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Remote Connection
There are various methods of remote connection to the Qx, that can be used depending on a user’s 
requirements. Users can connect remotely to the unit via VNC, REST API, SFTP, and web browser. 

Available Functionality
Operational control

VNC	 Remotely view the screen and control the Qx interface

REST API	 Remotely send Qx operational control commands and retrieve data and status 
information 

File management

SFTP	 Retrieve Log, Preset, and Screenshot files. Delete these files. Add saved presets 
from another Qx

Web Browser	 View and retrieve, Log, Preset and Screenshot files

Note: In the setup directions that follow, ‘192.168.0.70’ and ‘qx-020094.local’ have been used for example 
purposes only. Be sure to use the IP Address or mDNS Hostname specific to your Qx unit.

VNC
Direct screen control of the Qx can be provided via VNC. 

The Qx acts as the VNC Server, and a user can have remote access the unit using a VNC viewer software 
client application on their local computer.

Qx Setup

From the ‘Qx Network & Automation’ window, enable ‘VNC Server’ in the submenu.

The VNC Server setting will shows the number of current VNC connections. Once a connection is made, this 
number will be updated.

Connecting to the Qx VNC Server

Install your chosen VNC viewer software on the computer you will use to connect to the Qx.

Launch the VNC viewer application. 

To make a new connection to the Qx: 

	 • Enter the IP Address of the Qx unit (found in ‘Qx Network & Automation’ window) or its mDNS 		
	 Hostname (if mDNS is enabled on your computer)

	 • Enter the password: phabrixqx

A view of the Qx desktop will open on your computer screen. You will be able to control the Qx with your 
local mouse and keyboard.  

Note: No remote monitoring of the Qx unit audio output is available via VNC.

REST API
A REST API client can be used to remotely interrogate the Qx for data and status information, and to also 
send it operational control commands.
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Qx Setup

From the ‘Qx Network & Automation’ window, enable ‘REST API’ in the submenu.

When enabled, the REST API setting will show the port number (8080) the Qx is listening on. 

Connecting to the Qx via REST API

Run your chosen REST API client application on the computer you will use to connect to the Qx.

A connection to the Qx can be made using the IP Address or mDNS Hostname (if mDNS is enabled on your 
computer) of the Qx unit, together with the port number.  

For connection to the Qx: 

As a GET request; in the URL field of the REST API client, enter the Qx address using the specific IP Address 
or mDNS Hostname of your unit, in one of the following formats:

	 • http://192.168.0.70:8080/api 

	 • http://qx-020094.local:8080/api

See ‘Qx Network & Automation’ section of this manual, for an overview of Qx GET and PUT requests for 
REST API.

For full details of all available Qx REST API requests, see the Qx REST API Documentation available at:

IP Rest API - https://phabrix.com/api/qxip.html

12G Rest API - https://phabrix.com/api/qx12g.html    

PUT, GET, and DELETE requests can be scripted for automated testing use.

SFTP
Retrieval of Event Log, Preset, and Screenshot files, deletion of these files, and the addition of saved presets 
from another unit can be carried out using Secure File Transfer Protocol (SFTP).

Connecting to the Qx via SFTP

Run your chosen SFTP client application on the computer from which you will connect to the Qx (your SFTP 
server).

Enter the Qx host address using the specific IP Address of your Qx or its mDNS Hostname (if mDNS is 
enabled on your computer), in one of the following formats:

	 • sftp://192.168.0.70

	 • sftp://qx-020094.local

Additionally, provide the following:

Username: qxuser; Password: phabrixqx; Port: 22

Once connected, open the ‘transfer’ directory to access the ‘log’ (for the Event Log), ‘presets’, and 
‘screenshots’ folders. Files can be downloaded, deleted and added (in the case of ‘presets’) to these folders 
as required. 

Web Browser
A web browser can be used to view Event Log, Screenshot, and Preset files, and retrieve them.

Connecting to the Qx via web browser

In the web browser of your choice on your computer, enter the IP address of your Qx, in the following format:

	 • http://192.168.0.70

Once connected, access the ‘logs’, ‘presets’, and ‘screenshots’ folders as required. View and save files to 
your computer as required. 

Note: Files can only be copied and not deleted via a web browser

https://phabrix.com/api/qxip.html
https://phabrix.com/api/qx12g.html 
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Specifications
Power

Connector	 4-pin XLR, Male

Voltage	 10-18V, 12V DC nominal 
DC Power adapter provided 
Overvoltage, undervoltage and reverse voltage protection

External Locking Reference

Label	 REF

Input Signal	 Tri-level or Bi-Level (black burst) syncs 50/59.94/60Hz

Connector	 2x BNC

Input Impedance	 > 10kΩ

Input Return Loss	 >40dB to 6MHz (typical)

Maximum Input voltage 	 +/- 2V

Specification	 Tri-level syncs (SMPTE 274M and SMPTE 296M) 600 mV pk-pk 
PAL Black Burst (ITU 624-4/SMPTE 318) 1V pk-pk, 
Composite NTSC (SMPTE 170M) 1V pk-pk

SDI Instrument Output

Label	 SDI OUT

Connector	 BNC

Output Impedance	 75Ω

Output Level	 800mV p-p +/-10%

Purpose 		 3Gbps SDI instrument output

HDMI Instrument Output

Label	 HDMI

Connector	 Type A

Video Format	 1920 x 1080 RGB 4:4:4

Audio Format	 4 x PCM stereo audio at 48 KHz

Purpose	 Monitor output that allows up to 16 individual instrument panels (or windows) to be 
displayed.

USB

USB	 USB 2

USB Connector	 Type A

Quantity	 3 (1 x front mounted, 2 x rear mounted)

Purpose	 Keyboard and mouse control of the HDMI® monitor output of instrument and 
software installation.
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Networking

Ethernet	 IEEE 802.3 10/100/1000Mb/s (10/100/1000 base-T)

Ethernet Connector	 RJ-45

Rear panel D26

Label:			  I/O Expansion

Connector:		  26-way D-type

Purpose: 		  8x GPI I/O, 4x AES I/O, LTC input, stereo analog audio out

Pin out:

Pin Number Pin Name Description

1 AES_IO0 Bidirectional AES I/O - 75Ohm unbalanced

2 AES_IO1 Bidirectional AES I/O - 75Ohm unbalanced

3 AES_IO2 Bidirectional AES I/O - 75Ohm unbalanced

4 AES_IO3 Bidirectional AES I/O - 75Ohm unbalanced

5 LTC_RX_P LTC Receive (RX) P (RS-422 compatible)

6 LTC_RX_N LTC Receive (RX) N (RS-422 compatible)

7 AUDIO_R Audio Line Out - right

8 AUDIO_L Audio Line Out - left

9 5V0_GPIO 5V current limited GPIO supply (500mA)

10, 11, 12, 13, 14, 15, 16, 17, 18 GND 0V

19 GPIO-0 Open drain,10k pull-up to +5V

20 GPIO-1 Open drain,10k pull-up to +5V

21 GPIO-2 Open drain,10k pull-up to +5V

22 GPIO-3 Open drain,10k pull-up to +5V

23 GPIO-4 Open drain,10k pull-up to +5V

24 GPIO-5 Open drain,10k pull-up to +5V

25 GPIO-6 Open drain,10k pull-up to +5V

26 GPIO-7 Open drain,10k pull-up to +5V
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AES I/O
Connector	 26-way D-type

Pins	 1 (AES I/O 1), 2 (AES I/O 2), 3 (AES I/O 3), 4 (AES I/O 4)

Input Impedance	 75 Ω terminated

Maximum Input Voltage	 +/- 2V

Input Sample Rate	 48kHz synchronous audio

Input Bit Depth	 20bit or 24bit

Output Sample Rate	 48kHz synchronous to system reference

Output Bit Depth	 24bit

Specification	 Conforming to AES3-2003 and SMPTE-276M 

Purpose	 Not currently supported in software

Longitudinal Timecode (LTC) 

Connector	 26-way D-type

Pins	 5 (RX - P), 6 (RX-N)

Format	 RS-422 Compatible

Purpose	 Not currently supported in software

Analog Audio Output

Connector	 26-way D-type

Pins	 7 (Audio Line Out - Right), 8 (Audio Line Out - Left)

Type	 Stereo Pair

Level	 (1V peak-to-peak analog audio, full scale 0dBFS)

Purpose	 Audio Monitoring output

GPIO

Connector	 26-way D-type

Pins	 19 (GPIO - 0), 20 (GPIO - 1), 21 (GPIO - 2), 22 (GPIO - 3), 
23 (GPIO - 4), 24 (GPIO - 5), 25 (GPIO - 6), 26 (GPIO - 7)

Format	 open drain with 10kΩ pull-up to +5 Volts

Power	 5 Volt (pin 9), current-limted GPIO supply for ‘open drain’ input/outputs. 0 Volt/ 
signal ground (pins 10 to 18)

Purpose	 Not currently supported in software
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On-going Development

PHABRIX is committed to developing the tool-sets on the Qx to meet the very high expectations of its 
customers. There will be frequent upgrades which will include improvements to existing instruments and the 
addition of new ones.

Please do not hesitate to contact PHABRIX at any time to discuss your requirements for the product or to 
discuss the current product time-line.

SMPTE UHDTV: SDI PHYSICAL LAYER

-
Data Rate 1.485 Gbps 2.97 Gbps 5.94 Gbps 11.88 Gbps

Standard SMPTE ST292-1:2012 SMPTE ST424:2012 SMPTE ST2081-1,10 SMPTE ST2082-1,10

Coding Scrambled NRZI Scrambled NRZI Scrambled NRZI Scrambled NRZI

Amplitude 800 mV +/- 10% 800 mV +/- 10% 800 mV +/- 10% 800 mV +/- 10%

DC  O�set 0.0 V +/- 0.5 V 0.0 V +/- 0.5 V 0.0 V +/- 0.5 V 0.0 V +/- 0.5 V

Rise/Fall time: < 270 ps < 135 ps < 80 ps < 45 ps

Rise/Fall time di�erence: < 100 ps < 50 ps < 35 ps < 18 ps

Over/Under-shoot: <10% ofthe amplitude <10% ofthe amplitude <10% ofthe amplitude <10% ofthe amplitude

Timing Jitter < 1 UI
(10 Hz to 148.5 MHz)

< 2 UI
(10 Hz to 297 MHz)

< 4 UI
(10 Hz to 594 MHz)

< 8UI
(10 Hz to 1188 MHz)

Alignment Jitter < 0.2 UI
(100 kHz to 148.5 MHz)

< 0.3 UI
(100 kHz to 297 MHz)

< 0.3 UI
(100 kHz to 594 MHz)

< 0.3 UI
(100 kHz to 1188 MHz)

Qx 75 Ohm Coaxial cable length 200 m 200 m 100 m 70 m 
 

 Qx 75 Ohm Coaxial cable length
(Canare L-5.5CUHD)

   

100 m (colour bars)

(Belden 1694A)

Automatic measurement provided by Qx

The complexity of both analyzing and generating signals for UHDTV is exemplified above. The data 
bandwidth testing from HD through to UHDTV at 12Gbps, standard on the Qx, is immense and the 
parameters set by SMPTE require that the instruments measure these critical values for compliance.
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SMPTE Standards 
Link (Content) 

 
Interface 

 
Resolution 

 
Sampling 
Structure 

 
Pixel 

Depth 

 
Frame/Field Rate 

 
   SDR? 
  (Colour Space) 

 
  PQ HDR? 
  (Colour Space) 

 
  HLG HDR? 
  (Colour Space)  

 
ST 292 (ST 296) 

 
HD 

 
1280 x 720 

 
4:2:2 (YCbCr) 

 
10 

 
60p, 59.94p, 50p, 30p, 29.97p, 25p 

 
  Yes  
  (Rec.709) 

 
  Yes  
  (Rec.2020) 

 
  Yes  
  (Rec.2020) 

 
ST 292 (ST 274) 

 
HD 

 
1920 x 1080 

 
4:2:2 (YCbCr) 

 
10 

 
60i, 59.94i, 50i 

 
  Yes  
  (Rec.709, Rec. 2020) 

 
  Yes  
  (Rec.2020) 

 
  Yes  
  (Rec.2020) 

 
ST 292 (ST 274) 

 
HD 

 
1920 x 1080 

 
4:2:2 (YCbCr) 

 
10 

 
30p, 29.97p, 25p, 24p, 23.98p 

 
  Yes  
  (Rec.709, Rec. 2020) 

 
  Yes  
  (Rec.2020) 

 
  Yes  
  (Rec.2020) 

 
ST 292 (ST 274) 

 
HD 

 
1920 x 1080 

 
4:2:2 (YCbCr) 

 
10 

 
30psf, 29.97psf, 25psf, 24psf, 23.98psf 
 

 
  Yes  
  (Rec.709, Rec. 2020) 

 
  Yes  
  (Rec.2020) 

 
  Yes  
  (Rec.2020) 

 
ST 292 (ST 2048-2) 

 
HD 

 
2048 x 1080 

 
4:2:2 (YCbCr) 

 
10 

 
30p, 29.97p, 25p, 24p, 23.98p 
30psf, 29.97psf, 25psf, 24psf, 23.98psf 
 

 
  Yes  
  (Rec.709, Rec. 2020) 

 
  Yes  
  (Rec.2020) 

 
  Yes  
  (Rec.2020) 

 
ST 425-1 (ST 274) 

 
3G Level A,B (1) 

 
1920 x 1080 

 
4:2:2 (YCbCr) 

 
10 

 
60p, 59.94p, 50p 

 
  Yes  
  (Rec.709, Rec. 2020) 

 
  Yes  
  (Rec.2020) 

 
  Yes  
  (Rec.2020) 

 
ST 425-1 (ST 2048-2) 

 
3G Level A,B (1) 

 
2048 x 1080 

 
4:2:2 (YCbCr) 

 
10 

 
60p, 59.94p, 50p, 48p, 47.95p 

 
  Yes  
  (Rec.709, Rec. 2020) 

 
  Yes  
  (Rec.2020) 

 
  Yes  
  (Rec.2020) 

 
ST 425-1 (ST 296) 

 
3G Level A (2) 

 
1280 x 720 

4:4:4 (YCbCr/RGB) 
4:4:4:4 (YCbCrA/RGBA) 

 
10 

 
60p, 59.94p, 50p, 30p, 29.97p 

  Yes 
  (Rec.709, Rec. 2020) 

 
_ 

 
_ 

 
ST 425-1 (ST 274) 

 
3G Level A (2) 

 
1920 x 1080 

4:4:4 (YCbCr/RGB) 
4:4:4:4 (YCbCrA/RGBA) 

 
10 

60i, 59.94i, 50i 
30p, 29.97p, 25p, 24p, 23.98p 
30psf, 29.97psf, 25psf, 24psf, 23.98psf 
 

  Yes 
  (Rec.709, Rec. 2020) 

 
_ 

 
_ 

 
ST 425-1 (ST 2048-2) 

 
3G Level A (2) 

 
2048 x 1080 

4:4:4 (YCbCr/RGB) 
4:4:4:4 (YCbCrA/RGBA) 

 
10 

30p, 29.97p, 25p, 24p, 23.98p 
30psf, 29.97psf, 25psf, 24psf, 23.98psf 

  Yes 
  (Rec.709, Rec. 2020) 

 
_ 

 
_ 

 
ST 425-1 (ST 274) 

 
3G Level A (3) 

 
1920 x 1080 

 
4:4:4 (YCbCr/RGB) 

 
12 

60i, 59.94i, 50i 
30p, 29.97p, 25p, 24p, 23.98p 

  Yes 
  (Rec.709, Rec. 2020) 
 

 
_ 

 
_ 

 
ST 425-1 (ST 2048-2) 

 
3G Level A (3) 

 
2048 x 1080 

 
4:4:4 (YCbCr/RGB) 

 
12 

      30p, 29.97p, 25p, 24p, 23.98p 
30psf, 29.97psf, 25psf, 24psf, 23.98psf 
 

  Yes 
  (Rec.709, Rec. 2020) 
 

 
_ 

 
_ 

 
ST 425-1 (ST 274) 

 
3G Level A (4) 

 
1920 x 1080 

 
4:2:2 (YCbCr) 

 
12 

60i, 59.94i, 50i 
30p, 29.97p, 25p, 24p, 23.98p 
30psf, 29.97psf, 25psf, 24psf, 23.98psf 
 

  Yes 
  (Rec.709, Rec. 2020) 

 
_ 

 
_ 

 
ST 425-1 (ST 2048-2) 

 
3G Level A (4) 

 
2048 x 1080 

4:2:2 (YCbCr) 
4:2:2:4 (YCbCrA) 

 
12 

30p, 29.97p, 25p, 24p, 23.98p 
30psf, 29.97psf, 25psf, 24psf, 23.98psf 

  Yes 
  (Rec.709, Rec. 2020) 

 
_ 

 
_ 

ST 2081-10 M1, 
(ST 2036-1) 

 
6G-2SI* 

 
3840 x 2160 

 
4:2:2 (YCbCr) 

 
10 

 
30p, 29.97p, 25p, 24p, 23.98p 

  Yes 
  (Rec.709, Rec. 2020) 

  Yes 
  (Rec. 2020) 

  Yes 
  (Rec. 2020) 

ST 2081-10 M1, 
(ST 2048-1) 

 
6G-2SI* 

 
4096 x 2160 

 
4:2:2 (YCbCr) 

 
10 

 
30p, 29.97p, 25p, 24p, 23.98p 

  Yes 
  (Rec.709, Rec. 2020) 

  Yes 
  (Rec. 2020) 

  Yes 
  (Rec. 2020) 

 
ST 425-5 (ST 2036-1) 

 
Quad-link 3G-A (1) 2SI,SQ* 

 
3840 x 2160 

 
4:2:2 (YCbCr) 

 
10 

 
60p, 59.94p, 50p 

  Yes 
  (Rec.709, Rec. 2020) 

  Yes 
  (Rec. 2020) 

  Yes 
  (Rec. 2020) 

 
ST 425-5 (ST 2048-1) 

 
Quad-link 3G-A (1) 2SI,SQ* 

 
4096 x 2160 

 
4:2:2 (YCbCr) 

 
10 

 
60p, 59.94p, 50p, 48p, 47.95p 

  Yes 
  (Rec.709, Rec. 2020) 

  Yes 
  (Rec. 2020) 

  Yes 
  (Rec. 2020) 

 
ST 425-5 (ST 2036-1) 

 
Quad-link 3G-B (1) 2SI,SQ* 

 
3840 x 2160 

 
4:2:2 (YCbCr) 

 
10 

 
60p, 59.94p, 50p 

  Yes 
  (Rec.709, Rec. 2020) 

  Yes 
  (Rec. 2020) 

  Yes 
  (Rec. 2020) 

 
ST 425-5 (ST 2048-1) 

 
Quad-link 3G-B (1) 2SI,SQ* 

 
4096 x 2160 

 
4:2:2 (YCbCr) 

 
10 

 
60p, 59.94p, 50p, 48p, 47.95p 

  Yes 
  (Rec.709, Rec. 2020) 

  Yes 
  (Rec. 2020) 

  Yes 
  (Rec. 2020) 

ST 2081-11 M1, 
ST 425-5 (ST 2036-1) 

 
Dual-link 6G-2SI (I)* 

 
3840 x 2160 

 
4:2:2 (YCbCr) 

 
10 

 
60p, 59.94p, 50p 

  Yes 
  (Rec.709, Rec. 2020) 

  Yes 
  (Rec. 2020) 

  Yes 
  (Rec. 2020) 

ST 2081-11 M1, 
ST 425-5 (ST 2048-1) 

 
Dual-link 6G-2SI (I)* 

 
4096 x 2160 

 
4:2:2 (YCbCr) 

 
10 

 
60p, 59.94p, 50p, 48p, 47.95p 

  Yes 
  (Rec.709, Rec. 2020) 

  Yes 
  (Rec. 2020) 

  Yes 
  (Rec. 2020) 

ST 2082-10 M1, 
ST 425-5 (ST 2036-1) 

 
12G-2SI (I)* 

 
3840 x 2160 

 
4:2:2 (YCbCr) 

 
10 

 
60p, 59.94p, 50p 

  Yes 
  (Rec.709, Rec. 2020) 

  Yes 
  (Rec. 2020) 

  Yes 
  (Rec. 2020) 

ST 2082-10 M1, 
ST 425-5 (ST 2048-1) 

 
12G-2SI (I)* 

 
4096 x 2160 

 
4:2:2 (YCbCr) 

 
10 

 
60p, 59.94p, 50p, 48p, 47.95p 

  Yes 
  (Rec.709, Rec. 2020) 

  Yes 
  (Rec. 2020) 

  Yes 
  (Rec. 2020) 

 

Supported SDI standards
This version of software supports the following standards:

Please contact PHABRIX if you required support for any standards not listed here.

* Not applicable for IP 2022-6
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